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Using This Manual

Using This Manual

This User Manual provides information on how to use the FRAnalyzer sweep 
frequency response analyzer safely, properly and efficiently. The FRAnalyzer 
User Manual contains important safety rules for working with the FRAnalyzer. It 
gets you familiar with operating the FRAnalyzer, and provides a typical 
application example. Following the instructions in this manual will help you to 
prevent danger, repair costs and possible down time due to incorrect operation.

All users of the FRAnalyzer must read this User Manual and observe the 
contained instructions. Make sure that the manual is always available to the 
FRAnalyzer operator.

Reading the FRAnalyzer User Manual alone does not release you from the duty 
of complying with all national and international safety regulations relevant to 
working on power transformers.

Operator Qualifications

Working on power transformers can be extremely dangerous. Testing with the 
FRAnalyzer must be carried out only by qualified, skilled and authorized 
personnel. Before starting to work, clearly establish the responsibilities. 
Personnel receiving training, instructions, directions, or education on the 
FRAnalyzer must be under constant supervision of an experienced operator 
while working with the equipment.

Safety Standards

Testing with the FRAnalyzer must comply with the EN 50110-1 (VDE 0105 Part 
100) "Operation of Electrical Installations" safety standard. Moreover, follow 
additional relevant laws and internal safety standards as well as the safety rules 
in this User Manual (see "Safety Rules" on page 9).
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Safety Rules

Safety Rules

Before operating the FRAnalyzer sweep frequency response analyzer, read the 
following safety rules carefully. If you do not understand some safety rules, 
contact OMICRON electronics before proceeding. Observe the following safety 
rules when working with the FRAnalyzer.

General

Before connecting any test leads to a test object, always observe the five safety 
rules:

• Disconnect completely

• Secure from re-connection

• Verify that the installation is dead

• Carry out grounding and short-circuiting

Note: Grounding and short-circuiting is a general precaution before starting 
to work on the high-voltage power equipment. During a measurement, follow 
the instructions in 2.4 "Connecting the FRAnalyzer to a Power Transformer" 
on page 28.

• Provide protection against adjacent live parts

Before handling the FRAnalyzer in any way, connect its equipotential ground 
terminal with a solid connection of at least 6 mm2 cross-section to the ground 
terminal of the power transformer under test.

Do not open the FRAnalyzer housing.

Do not repair, modify, extend, or adapt the FRAnalyzer or any accessories.

Use only original accessories available from OMICRON electronics.

Use the FRAnalyzer and its accessories only in a technically sound condition 
and when its use is in accordance with the regulations. In particular, avoid 
disruptions that could in turn affect safety.
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Operation

Before operating the FRAnalyzer, ground it as described in "General" earlier.

Make sure that the ground terminal of the power transformer is in good 
condition, clean and free of oxidation.

Additional Precautions

The FRAnalyzer User Manual or alternatively the e-book in PDF format has 
always to be available on the site where the FRAnalyzer is being used. It must 
be read and observed by all users of the FRAnalyzer.

The FRAnalyzer may be used only as described in this User Manual. Any other 
use is not in accordance with the regulations. The manufacturer and/or 
distributor is not liable for damage resulting from improper usage. The user 
alone assumes all responsibility and risk.

Full compliance with the regulations also includes following the instructions 
provided in this User Manual.

Disclaimer

If the equipment is used in a manner not specified by the manufacturer, the 
protection provided by the equipment may be impaired.
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Introduction

1     Introduction

1.1    Frequency Response Analysis (FRA)

Power transformers are essential components of any power transmission and 
distribution system. The strong electrodynamic forces resulting from short-circuit 
faults in the power system and the high acceleration potentially emerging during 
transportation can give rise to severe deformations of the transformer windings 
and mechanical construction. Transformers can also be exposed to stress 
during installation and due to inrush current or seismic occurrences.

Consequently, the mechanical construction and the windings of power 
transformers are subject to high mechanical stress. Depending on the grade of 
the overstressing, this may cause mechanical deformation or defects of the 
transformer windings and magnetic core.

The equivalent circuit of the transformer winding includes the coil’s resistance 
and inductance as well as parasitic capacitances between consecutive coils and 
between the winding and the tank wall and the core. Figure 1-1: "Equivalent 
circuit of the transformer winding" on page 12 shows the circuitry of discrete 
RLC elements. The frequency response of the particular transformer winding is 
a unique characteristic depending on the transformer’s mechanical construction. 
Deformations of the transformer’s mechanical construction cause altering the 
values of the RLC elements and, consequently, the frequency response of the 
transformer windings changes. By measuring the frequency response of the 
transformer windings in a wide frequency range, defects in the windings and 
magnetic core of power transformers can be diagnosed.
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Figure 1-1:
Equivalent circuit of the 
transformer winding
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Figure 1-2: "FRA measurement results" compares the frequency responses of 
the phase U, V and W windings of a power transformer with those in a healthy 
condition. The deviations of the FRA measurement results indicate that the U 
and W phase windings might have a defect.

Figure 1-2:
FRA measurement 
results
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The following figure shows the windings of the phase U and the radial 
displacements of the windings.

Figure 1-3:
Radial coil deformation
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1.2    The FRAnalyzer

The FRAnalyzer is a sweep frequency response analyzer for power transformer 
core and winding diagnosis. Its concept – universal hardware controlled by 
software running on a computer – makes the FRAnalyzer an efficient and 
flexible solution for the diagnosis of power transformer windings and magnetic 
cores.

The FRAnalyzer evaluates the frequency response of the transformer windings 
by using the sweep frequency response analysis (SFRA) in the frequency 
domain. Figure 1-4: "Sweep frequency response analysis" shows the 
measurement procedure. A sinusoidal voltage with constant amplitude and 
variable discrete frequencies is applied to the winding under test and the 
frequency of the input signal is successively increased. The amplitude and 
phase of the output signal is measured against the frequency and the output-to-
input amplitude ratio and the phase shift between the output and input signals 
are evaluated.

Figure 1-4:
Sweep frequency 
response analysis

Transformer

Complex RLCM networkVariable frequency

Magnitude Phase

Sine wave generator
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The FRAnalyzer measures the frequency response of the transformer windings 
in a wide frequency range and compares it with that in a healthy condition. From 
the frequency response deviations, many different types of defects in the 
transformer winding and magnetic core can be diagnosed. These include:

• Coil deformation – axial and radial

• Faulty core grounds

• Partial winding collapse

• Hoop buckling

• Broken or loose clamps

• Shorted turns and open windings

• Core deformation

With the FRAnalyzer, you can measure the magnitude and phase, the 
impedance and the admittance frequency responses of the transformer 
windings. The measurement results are available on your computer for further 
processing and/or documentation.

The FRAnalyzer includes a DDS (direct digital synthesis) signal source with 
constant level and variable frequency for excitation of the transformer winding, 
two receivers processing the winding’s response and a microcontroller. A DC 
power converter generates voltages for powering the circuitry involved. The 
control software runs on a computer connected to the FRAnalyzer by USB 
interface. The FRAnalyzer is powered optionally from a battery or using an AC 
power supply.



17

Introduction

1.2.1   Block Diagram

Figure 1-5:
Block diagram
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1.2.2   Connectors and Operating Controls

The FRAnalyzer provides the following connectors and operating controls.

On the front panel:

• SOURCE connector (signal source output)

• REFERENCE (CH 1) connector (reference channel input)

• MEASUREMENT (CH 2) connector (measurement channel input)

Figure 1-6:
Front view of the 
FRAnalyzer

On the rear panel:

• Power switch

• DC power input

• Equipotential ground terminal

• 5 V DC output

• USB connector

Figure 1-7:
Rear view of the 
FRAnalyzer

SOURCE REFERENCE MEASUREMENT

DC power input USB connectorEquipotential ground terminal

Power switch 5 V DC output
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1.2.3   Standard Compliance

The FRAnalyzer complies with the following standards:

Table 1-1:
Standard compliance

Standard Description

IEC 61326:
Class B equipment
Performance criterion B

EMC requirements

Universal Serial Bus (USB) Specification, 
Revision 1.1 and Revision 2.0

USB interface
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1.2.4   Delivery

The FRAnalyzer delivery includes:

FRAnalyzer Battery pack AC power supply and 
battery charger 
(including international 
mains plug adapters)

Power cable USB cable 50 cm/1.6 ft 
with power cable for 
optical USB converter

USB 2.0 A/A cable 
1.8 m/6 ft

50  coaxial cable 
18 m/60 ft (yellow)

50  coaxial cable 
18 m/60 ft (red)

50  coaxial cable 
18 m/60 ft (blue)
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Note: The FRAnalyzer User Manual is also available as eBook in the 
Documentation folder on the FRAnalyzer CD-ROM.

Optical USB cable 
20 m/65 ft

Grounding cable (GR/YE) 
6 m/20 ft, 6 mm2

4 × Aluminium braid 
25 mm2 roll

Insulation sleeve BNC T adapter for 
calibration

BNC adapter set

2 × Bushing clamp 4 × Screw clamp File

Transport case FRAnalyzer CD-ROM FRAnalyzer User Manual
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Installation

2     Installation

Before installing the FRAnalyzer, check the environmental and power 
requirements (see 6 "Technical Data" on page 105).

2.1    Installing the Software

For the minimum requirements your computer needs to run the FRAnalyzer 
software, see 6.2 "Computer Requirements" on page 106.

Note: Install the FRAnalyzer software before connecting the FRAnalyzer to the 
computer.

To install the FRAnalyzer software, put the delivered FRAnalyzer CD-ROM in 
the CD-ROM drive and follow the instructions on the screen.
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2.2    Powering the FRAnalyzer

The FRAnalyzer is powered optionally with an AC power supply1 or from a 
battery.

2.2.1   Powering with an AC Power Supply

To power the FRAnalyzer using the delivered AC power supply:

1. Plug the DC output connector of the AC power supply into the DC power 
input on the FRAnalyzer rear panel (see Figure 1-7: "Rear view of the 
FRAnalyzer" on page 18).

2. Fit the mains plug of the AC power supply to the power outlet, if necessary.

3. Connect the mains plug of the AC power supply to the power outlet.

4. Press the power switch on the FRAnalyzer rear panel.

2.2.2   Powering from a Battery

To power the FRAnalyzer from the battery:

1. Plug the power cable into the DC power output of the battery pack.

2. Plug the other end of the power cable into the FRAnalyzer DC power input.

Figure 2-1:Connecting 
battery pack to the 
FRAnalyzer

3. Press the power switch on the FRAnalyzer rear panel.

1. The delivered AC power supply is a battery charger for 12 V lead acid storage batteries. It is
suitable for powering the FRAnalyzer directly, too.

FRAnalyzer

DC power 
input

Power cable

DC power 
output

Battery pack

Power switch
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2.2.3   Charging the Battery

With the battery pack delivered with your FRAnalyzer, you can check the battery 
voltage and charge the battery even while the battery powers the FRAnalyzer. 
To check the battery voltage, press the green button on the battery pack. The 
needle within the green area indicates adequate battery voltage. If the needle is 
in the yellow zone, charge the battery immediately.

To charge the battery:

1. Plug the DC output connector of the AC power supply into the DC power 
input of the battery pack.

Figure 2-2:
Connecting AC power 
supply to battery pack

2. Fit the mains plug of the AC power supply to the power outlet, if necessary.

3. Connect the mains plug of the AC power supply to the power outlet.

When the battery is finished charging, the green LED on the AC power supply 
lights. You can charge the battery even while powering the FRAnalyzer (see 
2.2.2 "Powering from a Battery" on page 24).

Note: When charging the battery while powering the FRAnalyzer, the red LED 
on the power adapter lights permanently.

Battery pack

DC power input

Button for checking 
battery voltage

Fuse
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2.3    Connecting the FRAnalyzer to the Computer

The FRAnalyzer communicates with the computer through the USB interface 
(see 6.2 "Computer Requirements" on page 106). To connect the FRAnalyzer 
to the computer:

1. Connect the USB cable 50 cm/1.6 ft to the FRAnalyzer USB connector.

2. Connect the power cable for the optical USB converter to the FRAnalyzer 
5 V DC output.

Figure 2-3:
Connecting the USB 
cable and power cable 
for the optical USB 
converter

3. Guide the USB cable with the power cable for the optical USB converter to 
the front of the transport case.

Note: Make sure not to crush the cables when closing the transport case.

4. Connect the USB cable on the front of the transport case to the USB 
connector of your computer using either the USB 2.0 A/A cable or the optical 
USB cable. If using the optical USB cable, connect the power cable for optical 
USB converter to the power connector of the optical USB cable.

FRAnalyzer

5 V DC output

USB connector

USB cable 
50 cm/1,6 ft

Power cable 
for optical USB 
converter
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Figure 2-4:
Connecting the 
FRAnalyzer with the 
computer using the USB 
2.0 A/A cable

Figure 2-5:
Connecting the 
FRAnalyzer with the 
computer using the 
optical USB cable

USB 2.0 A/A cable

Optical USB cable
Power cable for optical 
USB converter



 FRAnalyzer User Manual

28

2.4    Connecting the FRAnalyzer to a Power 
Transformer

Note: Before connecting the FRAnalyzer to a power transformer and performing 
measurements, it is recommended to calibrate the FRAnalyzer (see 
3.11 "Calibrating the FRAnalyzer" on page 80).

For testing a power transformer, connections are defined by the test (see 
4.1 "Test Traces" on page 83). For each test trace, the FRAnalyzer assigns the 
SOURCE, REFERENCE and MEASUREMENT connectors to the transformer’s 
terminal bushings. To perform a measurement, connect the FRAnalyzer to the 
power transformer under test as follows:

1. Fasten a bushing clamp to the transformer’s terminal bushing that 
corresponds to the identifying name shown in the list next to the Red label 
(representing the REFERENCE terminal) in the Test View window (see 
3.2 "Test View Window" on page 47).

2. Connect the yellow and red coaxial cables to the BNC connector on the 
bushing clamp by using a delivered BNC adapter.
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3. Connect the aluminium braids to the bushing clamp using the screws on the 
bushing clamp and tighten the screws.
If necessary, use the delivered insulation sleeve to prevent electrical contact 
between the aluminium braid and the bushing.

Note: It is recommended to use two aluminium braids for grounding the 
bushings clamps, especially for long bushings. Prevent overbending of the 
aluminium braids and pull them carefully not to break the small strands.

Figure 2-6:
Connecting the bushing 
clamp with the yellow 
and red coaxial cables

4. Connect the aluminium braids to the transformer’s tank using the screw 
clamps. You can use the clamps in two different ways as shown in Figure 
2-7: "Fastening the screw clamp" and Figure 2-8: "Alternative way of 
fastening the screw clamp" on page 30. Choose one of the two positions to 
connect the aluminium braid as near as possible to the ceramic isolation to 
reach a good grounding connection. Make sure that all clamps and braids are 
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screwed tight and that there is a good electrical contact between the clamps 
and the transformer’s tank. If in doubt, remove the varnish with the delivered 
file.

Note: We recommend to test the quality of the contact with a multimeter.

Figure 2-7:
Fastening the screw 
clamp

Figure 2-8:
Alternative way of 
fastening the screw 
clamp
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5. Fasten a bushing clamp to the transformer’s terminal bushing that 
corresponds to the identifying name shown in the list next to the Blue label 
(representing the MEASUREMENT terminal) in the Test View window (see 
3.2 "Test View Window" on page 47).

6. Connect the blue coaxial cable to the BNC connector on the bushing clamp.

Figure 2-9:
Connecting the bushing 
clamp with the blue 
coaxial cable

7. To ground the bushing clamp, repeat steps 3 and 4.

8. If not already done, connect the other ends of the three BNC cables to the 
corresponding color-coded connector ports (SOURCE, REFERENCE, 
MEASUREMENT) on the front panel of the FRAnalyzer.



 FRAnalyzer User Manual

32



33

The FRAnalyzer Software

3     The FRAnalyzer Software

This section gets you familiar with the FRAnalyzer software. The FRAnalyzer 
software user interface has four windows for managing data, viewing and 
processing tests, comparing test traces and assessing measurement results. 
You can switch between the windows by clicking the respective tab.

3.1    Data Management Window

After starting the FRAnalyzer software, the Data Management window opens. 
In the Data Management window, you can manage the transformer, test and 
trace data. The Data Management window has two panes: the edit pane and 
the record pane. The record pane is divided into the Transformers area, the 
Tests area and the Traces area.

Figure 3-1:
Data Management 
window

Edit pane Record pane

Toolbar

Status bar

Transformers area

Tests area Traces area
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3.1.1   Data Management Window Edit Pane

The edit pane of the Data Management window has three tabbed pages for 
editing the transformer, test and trace data relevant to the respective record 
selected in the record pane. You can show and hide the edit pane by clicking the 
Edit Pane toolbar button  or Edit Pane on the View menu.

On the Transformer Details tab of the edit pane, you can edit the data of the 
transformer record selected in the Transformers area.

Figure 3-2:
Edit pane: Transformer 
Details tab
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The transformer data is described in the following table.

Table 3-1:
Transformer data

On the Test Details tab of the edit pane, you can edit the data of the test record 
selected in the Tests area.

Figure 3-3:
Edit pane: Test Details 
tab

Data Description

Serial Number Serial number of the transformer

Manufacturer Name of the transformer’s manufacturer

Type Code Type code of the transformer’s manufacturer

Year Manufacturing year of the transformer

Location Physical location of the transformer

Number Transformer’s number or user-defined inventory number

Autotransformer Select the Autotransformer check box if the 
transformer is an autotransformer.

MVA Rating Transformer’s MVA rating in MVA

V High (kV) Transformer’s high side voltage in kV

V Low (kV) Transformer’s low side voltage in kV

V Tertiary (kV) Transformer’s tertiary side voltage in kV

Phases Number of the transformer’s phases

Vector Group Vector group of the transformer’s windings
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The test data is described in the following table.

Table 3-2:
Test data

By using the Sweep Settings button, you can set the frequency sweep 
parameters. For more information, see 3.8 "Sweep Settings" on page 75.

On the Trace Details tab of the edit pane, you can edit the data of the trace 
record selected in the Traces area.

Figure 3-4:
Edit pane: 
Trace Details tab

Data Description

State1

1. Displayed in the record pane only

State of the test (tested, not tested)

Test Name Short description of the test

Tester Name of the person who performed the test

Date Date the test was performed
(automatically set by the system)

Time Time the test was performed
(automatically set by the system)

Location Physical location the test was performed

Oil Temperature Temperature of the transformer’s oil

Comment2

2. It is recommended to type here the test details, particularly the reason for the test.

Comment on the test
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The trace data is described in the following table.

Table 3-3:
Trace data

Data Description

State1

1. Displayed in the record pane only

State of the trace (tested, not tested)

Name Trace name

Red Transformer’s terminal to be connected to the 
REFERENCE connector (red)

Blue Transformer’s terminal to be connected to the 
MEASUREMENT connector (blue)

Date/Time Date and time of the trace record

Tap Changer Tap changer setting of the transformer

Delta Winding Open Select the Delta Winding Open check box if a 
transformer’s delta winding is open.

Other Windings Click open, grounded, shorted, or 
shorted + grounded if other transformer’s 
windings are terminated respectively.

Comment2

2. It is recommended to type here the test trace details for better data organization.

Comment on the trace
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3.1.2   Data Management Window Record Pane

In the record pane of the Data Management window (see Figure 
3-1: "Data Management window" on page 33), you can process transformer, 
test and trace records.

Note: For simplicity, the transformer, test and trace records (see 
3.1 "Data Management Window" on page 33) are also called transformers, tests 
and traces if no ambiguity arises.

Transformers 
Area

In the Transformers area of the record pane, transformer records are 
displayed. A transformer record is a set of data relevant to a transformer. The 
transformer records are arranged in tabular form with rows corresponding to the 
transformers and columns displaying the transformer data.

By using the Transformers area shortcut menu, you can process the 
transformer records. To open the shortcut menu, right-click in the Transformers 
area.

Figure 3-5:
Transformers area 
shortcut menu

Note: The Transformers area shortcut menu is identical to the Transformer 
menu in the menu bar.

Table 3-4:
Commands on the 
Transformers area 
shortcut menu

Command Description

Edit Displays the Transformer Details tab for editing 
the transformer data.

New Adds a new transformer and displays the 
Transformer Details tab for editing the 
transformer data.

Delete Deletes the selected transformer.

Import Imports the transformer data (see 3.9 "Importing 
and Exporting Data" on page 77).

Export Exports the transformer data (see 3.9 "Importing 
and Exporting Data" on page 77).

Export in CIGRE Format Exports the transformer data in CIGRE format (see 
3.9 "Importing and Exporting Data" on page 77).
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To add a transformer:

1. Do one of the following:

• In the Transformers area, click the New button.

• Click the New Transformer toolbar button .

• Right-click in the Transformers area, and then click New.

2. In the New Transformer dialog box, type the serial number of the 
transformer you want to add.

3. In the edit pane, enter the transformer data.

Note: The vector group can only be set if the transformer phase number is three.

To edit a transformer:

1. In the Transformers area, click the transformer you want to edit.

2. In the edit pane, edit the transformer data.

To delete a transformer, do one of the following:

• In the Transformers area, click the transformer you want to delete, and then 
click the Delete button or press the DEL key.

• In the Transformers area, right-click the transformer you want to delete, and 
then click Delete.

Note: By clicking the respective command on the Transformer menu, you can 
process transformer records even if any window is open or if the edit pane is 
hidden.
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Tests Area In the Tests area of the record pane, the test records available for the 
transformer selected in the Transformers area are displayed. A test record is a 
set of data relevant to a test. The test records are arranged in tabular form with 
rows corresponding to the tests and columns displaying the test data.

By using the Tests area shortcut menu, you can process the test records. To 
open the shortcut menu, right-click in the Tests area.

Figure 3-6:
Tests area shortcut 
menu

Note: The Tests area shortcut menu is identical to the Test menu in the menu 
bar.

Table 3-5:
Commands on the 
Tests area shortcut 
menu

Command Submenu Description

Open in Test View Displays the selected test in the 
Test View window.

Edit Displays the Test Details tab for 
editing the test data.

New Adds a new test and displays the 
Test Details tab for editing the test 
data.

Use as Template Adds a new test by using the 
selected test as template.

Delete Deletes the selected test.

Sweep Settings Enables you to specify the sweep 
settings (see 3.8 "Sweep Settings" 
on page 75).

Import Imports transformer data (see 
3.9 "Importing and Exporting Data" 
on page 77).
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When adding a test, you can create test traces according to a standard or use 
an existing test as template. For more information on the test traces, see 
4.1 "Test Traces" on page 83.

Note: A new test is always added to the transformer selected in the 
Transformers area.

Export Exports transformer data (see 
3.9 "Importing and Exporting Data" 
on page 77).

Export in CIGRE 
Format

Exports transformer data in CIGRE 
format (see 3.9 "Importing and 
Exporting Data" on page 77).

Add to Comparison

Add All Traces Adds all traces of the selected test 
to a comparison
(see 3.3 "Comparison Window" on 
page 54).

Add All High 
Voltage Traces

Adds all high-voltage traces of the 
selected test to a comparison
(see 3.3 "Comparison Window" on 
page 54).

Add All Low 
Voltage Traces

Adds all low-voltage traces of the 
selected test to a comparison
(see 3.3 "Comparison Window" on 
page 54).

Add All Tertiary 
Voltage Traces

Adds all tertiary-voltage traces of 
the selected test to a comparison
(see 3.3 "Comparison Window" on 
page 54).

Add All 
Interwinding 
Traces

Adds all interwinding traces of the 
selected test to a comparison
(see 3.3 "Comparison Window" on 
page 54).

New Assessment Enables you to configure a new 
assessment (see 3.4 "Assessment 
Window" on page 59).

Command Submenu Description
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To add a test:

1. In the Transformers area, select the transformer to which you want to add a 
test.

2. Do one of the following:

• In the Tests area, click the New button.

• Click the New Test toolbar button .

• Right-click in the Tests area, and then click New.

3. In the New Test dialog box, type the name of the test.

4. Select a standard for creating the default test traces.

5. Click OK.

6. In the Traces area, the default test traces according to the FRA testing 
recommendations are displayed.

7. In the edit pane, enter the test data.

To add a test by using a template:

1. In the Transformers area, select the transformer to which you want to add a 
test.

2. In the Tests area, select the test you want to use as template.

3. Right-click in the Tests area, and then click Use as Template.

4. In the New Test dialog box, type the name of the test.

5. Click OK.

6. In the Traces area, the default test traces specified by the test template are 
displayed.

7. In the edit pane, enter the test data.

To edit a test:

1. In the Tests area, click the test you want to edit.

2. In the edit pane, edit the test data.

To delete a test, do one of the following:

• In the Tests area, click the test you want to delete, and then click the Delete 
button or press the DEL key.

• In the Tests area, right-click the test you want to delete, and then click 
Delete.

Note: By clicking the respective command on the Test menu, you can process 
test records even if any window is open or if the edit pane is hidden.
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Traces Area In the Traces area of the record pane, the trace records available for the test 
selected in the Tests area are displayed. A trace record is a set of data relevant 
to a trace. The trace records are arranged in tabular form with rows 
corresponding to the traces and columns displaying the trace data.

Note: To select more trace records, hold down CTRL or SHIFT and click the 
trace records you want to select.

By using the Traces area shortcut menu, you can process the trace records. To 
open the shortcut menu, right-click in the Traces area.

Figure 3-7:
Traces area shortcut 
menu

Note: The Traces area shortcut menu is identical to the Trace menu in the 
menu bar.

Table 3-6:
Commands on the 
Traces area shortcut 
menu

Command Submenu Description

Edit Displays the Trace Details tab for 
editing the test data.

Preview Traces Displays a preview of a trace when 
pointing to the trace record.

New Adds a new trace and displays the 
Trace Details tab for editing the 
trace data.

Use as Template Adds a new test trace by using the 
selected trace as template.

Move to Other Test Moves the selected trace to 
another test.
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You can add an arbitrary test trace or use an existing trace as template. For 
more information on the test traces, see 4.1 "Test Traces" on page 83.

Note: The default test traces are created by the FRAnalyzer software according 
to the FRA testing recommendations. Change the default test traces only in well-
founded cases.

Note: A new trace is always added to the test selected in the Tests area.

Clear Results Clears the measurement results of 
the selected trace.

Delete Deletes the selected trace.

Start Measurement Starts measuring a trace.

Stop Measurement Stops measuring a trace.

Change Color Enables you to change the line 
color of the selected trace.

Change Line Style Line Sets the continuous line style for 
the selected trace.

Dash Sets the dash line style for the 
selected trace.

Dash-Dot Sets the dash-dot line style for the 
selected trace.

Dash-Dot-Dot Sets the dash-dot-dot line style for 
the selected trace.

Compare Compares the selected test traces 
(see 3.3 "Comparison Window" on 
page 54).

Add to Comparison Available 
comparisons

Adds the selected traces to a 
comparison (see 3.3 "Comparison 
Window" on page 54).

Group 
Comparisons by 
Tags

Groups available comparisons by 
tags.

Create 
Assessment(s)

Enables you to configure a new 
assessment (see 3.4 "Assessment 
Window" on page 59).

Show Connection 
Information

Displays the connection of the 
FRAnalyzer to the transformer 
under test.

Command Submenu Description
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To add a new test trace:

1. In the Tests area, select the test to which you want to add a trace.

2. Do one of the following:

• In the Traces area, click the New button.

• Click the New Trace toolbar button .

• Right-click in the Traces area, and then click New.

3. In the New Trace dialog box, clear the Generate name automatically 
check box if you want to change the default trace’s name.

4. In the Red list, click the transformer’s terminal to be connected to the 
REFERENCE connector (red).

5. In the Blue list, click the transformer’s terminal to be connected to the 
MEASUREMENT connector (blue).

6. Optionally, edit the trace’s name.

7. Click OK.

8. In the edit pane, enter the trace data.

To add a new test trace by using a template:

1. In the Tests area, select the test to which you want to add a trace.

2. Right-click in the Traces area, and then click Use as Template.

3. In the New Trace dialog box, type the trace’s name.

4. Click OK.

5. In the edit pane, enter the trace data.

To edit a test trace:

1. In the Traces area, click the trace you want to edit.

2. In the edit pane, edit the trace data.

To delete a test trace, do one of the following:

• In the Traces area, click the trace you want to delete, and then click the 
Delete button.

• In the Traces area, right-click the trace you want to delete, and then click 
Delete.

To set the test trace line color:

1. In the Traces area, right-click the trace whose color you want to set, and then 
click Change Color.

2. In the Color palette, specify the line color.
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To set the test trace line style:

1. In the Traces area, right-click the trace whose style you want to set.

2. Point to Change Line Style, and then click the line style.

Note: By clicking the respective command on the Trace menu, you can process 
trace records even if any window is open or if the edit pane is hidden.
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3.2    Test View Window

In the Test View window, you can view and process the transformer winding 
measurement results.

To open the Test View window, do one of the following:

• In the Tests area of the Data Management window, right-click a test record, 
and then click Open in Test View.

• In the Tests area of the Data Management window, double-click a test 
record.

• Click the Test View tab.

• On the Test menu, click Open in Test View.

• On the View menu, point to Page, and then click Test View.

The Test View window has three panes: the edit pane, the display pane and the 
cursor pane.

Figure 3-8:
Test View window Edit pane Display paneCursor pane
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By clicking the Edit Pane toolbar button  or Edit Pane on the View menu, 
you can hide the edit pane to have a more detailed view of the diagram as shown 
in the following figure.

Figure 3-9:
Test View window with 
the edit pane hidden

3.2.1   Test View Window Edit Pane

In the edit pane of the Test View window, you can specify the test traces to be 
displayed in the display pane and process them. You can show and hide the edit 
pane by clicking the Edit Pane toolbar button  or Edit Pane on the View 
menu.

In the edit pane of the Test View window, you can process the traces 
analogously as in the Traces area of the Data Management window. To open 
the shortcut menu, right-click in the Traces in Test ’Test Name’ area.
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Figure 3-10:
Traces in Test 
’Test Name’ area 
shortcut menu

Note: The Traces in Test ’Test Name’ area shortcut menu is identical to the 
Trace menu.

For the commands available on the Traces area shortcut menu, see Table 
3-6: "Commands on the Traces area shortcut menu" on page 43.

By using the Show command, you can display test traces individually.

To display test traces in the display pane:

1. In the Transformer list, click the transformer associated with the test you 
want to display.

2. In the Test list, click the test you want to display.

3. In the Traces in Test ’Test Name’ area, select the Show check box next to 
the trace you want to display or right-click the trace you want to display, and 
then click Show.

By using the Show Group command, you can display test traces grouped by the 
transformer’s voltage side.

To display a group of test traces in the display pane:

1. Right-click in the Traces in Test ’Test Name’ area.

2. Point to Show Group, and then click All Traces, All High Voltage Traces, 
All Low Voltage Traces, All Tertiary Voltage Traces or 
All Interwinding Traces to display the respective test trace group.
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After clicking the Edit button next to the Transformer box and the Edit button 
next to the Test box, you can edit the transformer and test data respectively. For 
more information, see 3.1.1 "Data Management Window Edit Pane" on page 34. 
Under Selected Trace, you can edit the data of the test trace selected in the 
Traces in Test ’Test Name’ area.

To add a new test trace:

1. In the Transformer list, click the transformer associated with the test you 
want to display.

2. In the Test list, click the test you want to display.

3. Click the New Trace toolbar button  or right-click in the 
Traces in Test ’Test Name’ area, and then click New.

4. In the New Trace dialog box, clear the Generate name automatically 
check box if you want to change the default trace’s name.

5. In the Red list, click the transformer’s terminal to be connected to the 
REFERENCE connector (red).

6. In the Blue list, click the transformer’s terminal to be connected to the 
MEASUREMENT connector (blue).

7. Optionally, edit the trace’s name.

8. In the edit pane, enter the trace data.

To delete a test trace:

1. In the Traces in Test ’Test Name’ area, right-click the trace you want to 
delete.

2. Click Delete.

To set the test trace line color:

1. In the Traces in Test ’Test Name’ area, right-click the trace whose color 
you want to set.

2. Click Change Color.

3. In the Color palette, specify the line color.

To set the test trace line style:

1. In the Traces in Test ’Test Name’ area, right-click the trace whose style you 
want to set.

2. Point to Change Line Style, and then click the line style.

Note: By clicking the respective command on the Trace menu, you can process 
trace records if any window is open or if the edit pane is hidden.
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3.2.2   Test View Window Display Pane

The display pane of the Test View window displays the frequency responses of 
the test traces specified in the edit pane. New test traces are displayed in the 
default color set in the Options dialog box (see 3.7 "Setting Options" on 
page 66). You can change the test trace color and style as described in 
3.2.1 "Test View Window Edit Pane" on page 48.

By using the display pane shortcut menu, you can control the graphical display. 
To open the shortcut menu, right-click in the display pane.

Figure 3-11:
Display pane shortcut 
menu

Table 3-7:
Commands on the 
display pane shortcut 
menu

Command Submenu Description

Show Available test 
traces

Displays the selected test traces.

Show Group1

All Traces Displays all test traces.

All High Voltage 
Traces

Displays all high-voltage traces.

All Low Voltage 
Traces

Displays all low-voltage traces.

All Tertiary 
Voltage Traces

Displays all tertiary-voltage traces.

All Interwinding 
Traces

Displays all interwinding traces.

Display Traces 

As1

Magnitude Displays the magnitude and phase 
frequency response of the test traces.

Impedance Displays the impedance frequency 
response of the test traces.

Admittance Displays the admittance frequency 
response of the test traces.
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Scaling
Logarithmic1 Displays the X-axis logarithmic scale.

Linear1 Displays the X-axis linear scale.

Highlight 
Selected Trace

Displays the selected trace with a 
thicker line width.

Show Markers Displays every measured point as a 
marker to provide information about 
the resolution of the measurement.

Zoom Mode Enables you to display the diagram in 
the zoom area.

Optimize Zoom

All1 Sets the X-axis and Y-axis ranges to fit 
the measurement results.

X-Axis Sets the X-axis range to fit the 
measurement results.

Y-Axis Sets the Y-axis range to fit the 
measurement results.

Reset Zoom Sets the X-axis and Y-axis to their full 
display range.

Save Image As Saves the displayed diagram as a 
graphic.

Copy Copies the displayed diagram to the 
clipboard.

1. Also available on the toolbar

Command Submenu Description
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3.2.3   Test View Window Cursor Pane

In the cursor pane of the Test View window, you can examine the measurement 
results in detail. For the test traces assigned to the cursors, the cursor pane 
displays the frequency and the measurement results at cursor positions. To 
assign a test trace to a cursor, select the check box next to the cursor, and then 
click the trace in the corresponding Trace list. You can show and hide the cursor 
pane by clicking the Cursors Table toolbar button  or Cursors Table on the 
View menu.

Figure 3-12:
Test View window 
cursor pane

In the cursor pane, the measured magnitude and phase of the frequency 
response and the calculated values of the impedance and admittance are 
displayed. In the Delta C2-C1 row, the differences between the values at the 
positions of cursor 2 and cursor 1 are displayed.
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3.3    Comparison Window

In the Comparison window, you can compare an arbitrary number of test 
traces. By using this tool, you can directly compare test traces of different tests 
by displaying them in one figure.

To open the Comparison window, do one of the following:

• Click the Comparison tab.

• On the View menu, point to Page, and then click Comparison.

The Comparison window has three panes: the edit pane, the display pane and 
the cursor pane. In the following figure, the cursor pane is hidden. You can 
display it by clicking the Cursors Table toolbar button  or Cursors Table on 
the View menu. 

Figure 3-13:
Comparison window

Edit pane Display pane
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3.3.1   Comparison Window Edit Pane

In the edit pane of the Comparison window, you can process trace 
comparisons. A comparison is a collection of test traces you want to compare. 
You can show and hide the edit pane by clicking the Edit Pane toolbar 
button  or Edit Pane on the View menu.

In the Comparisons area, the available comparisons are displayed. The 
FRAnalyzer software provides a <default> comparison as a trace container for 
trial comparisons which you do not want to save. After renaming it, the 
<default> comparison becomes a regular comparison which you can process 
as described later, and a new <default> comparison is added and stored.

By using the Comparisons area shortcut menu, you can process the 
comparisons. To open the shortcut menu, right-click in the Comparisons area.

Figure 3-14:
Comparisons area 
shortcut menu

Table 3-8:
Commands on the 
Comparisons area 
shortcut menu

In the Traces in Comparison area, the traces belonging to the selected 
comparison are displayed.

Figure 3-15:
Traces in Comparison 
area shortcut menu

Command Description

New Opens the New Comparison dialog box for 
adding a comparison.

Delete Deletes the selected comparison.
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For the commands available on the Traces in Test ’Test Name’ area shortcut 
menu, see 3.2.1 "Test View Window Edit Pane" on page 48.

By using the Move to Comparison command, you can add test traces to a 
comparison.

By using the Remove from Comparison command, you can remove test 
traces from a comparison.

To add a comparison:

1. In the Comparisons area, click the New button or click the 
New Comparison toolbar button .

2. In the New Comparison dialog box, type the comparison name.

3. In the Traces in Comparison area, click the Add button.

4. In the Add Traces to Comparison dialog box, configure the comparison as 
follows:

• Select the test trace you want to add to the comparison, and then click the 
Add Selected button.

Note: To add more test traces at once, hold down CTRL or SHIFT and 
click the traces you want to add.

• Click the Add All button to select all traces available for the selected test 
and the associated transformer.

5. Repeat step 4 for all test traces you want to add to the comparison.

Under Comparison Details, you can edit the data of the selected comparison 
and assign a tag to the comparison. You can then group the comparisons by the 
tags.

To assign a tag to a comparison:

1. Under Comparisons, select the comparison to which you want to assign a 
tag.

2. Under Comparison Details, enter the tag name in the Tag list.

3. Press the ENTER key.
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You can add grouped traces of a test or separate test traces to a comparison.

To add grouped test traces to a comparison:

1. In the Comparisons area of the Comparison window, select the 
comparison to which you want to add test traces.

2. Click the Data Management tab, and then do one of the following:

• In the Tests area of the Data Management window, right-click the test 
including the traces you want to add to the comparison, point to 
Add to Comparison, and then click the test traces you want to add.

• In the Tests area of the Data Management window, click the test 
including the traces you want to add to the comparison, point to 
Add to Comparison on the Test menu, and then click the test traces you 
want to add.

To add separate test traces to the selected comparison:

1. In the Comparisons area of the Comparison window, click the comparison 
to which you want to add test traces.

2. Click the Data Management tab.

3. In the Traces area of the Data Management window, select the traces you 
want to add to the comparison, and then click the Add To Comparison 
toolbar button .

To add separate test traces to an arbitrary comparison:

1. In the Traces area of the Data Management window, select the traces you 
want to add to the comparison, and then do one of the following:

• Click the arrow next to the Add To Comparison toolbar button , and 
then click the comparison to which you want to add the traces.

• Right-click in the Traces area, point to Add To Comparison, and then 
click the comparison to which you want to add the traces.

Alternatively, you can add test traces to a comparison analogously in the 
Test View window.
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To remove a test trace from a comparison:

1. In the Comparisons area, click the comparison from which you want to 
remove a test trace.

2. In the Traces in Comparison area, do one of the following:

• Click the trace you want to remove, and then click the Remove button.

• Right-click the trace you want to remove, and then click 
Remove from Comparison.

To delete a comparison, do one of the following:

• In the Comparisons area, click the comparison you want to delete, and then 
click the Delete button.

• In the Comparisons area, right-click the comparison you want to delete, and 
then click Delete.

3.3.2   Comparison Window Display Pane

The display pane of the Comparison window displays the frequency responses 
of the compared test traces. For the shortcut menu commands, see 
3.2.2 "Test View Window Display Pane" on page 51.

3.3.3   Comparison Window Cursor Pane

In the cursor pane of the Comparison window, you can examine the 
measurement results in detail. You can show and hide the cursor pane by 
clicking the Cursors Table toolbar button  or Cursors Table on the View 
menu. For more information, see 3.2.3 "Test View Window Cursor Pane" on 
page 53.
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3.4    Assessment Window

With the FRAnalyzer, you can assess the transformer windings by evaluating 
the difference between the frequency responses of two comparable test traces. 
For detailed information, see 4.5 "Analysis Algorithms" on page 88. You can 
configure and perform the winding assessment in the Assessment window.

To open the Assessment window, do one of the following:

• Click the Assessment tab.

• On the View menu, point to Page, and then click Assessment.

The Assessment window has three panes: the edit pane, the display pane and 
the cursor pane.

Figure 3-16:
Assessment window

Edit pane Display paneCursor pane
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3.4.1   Assessment Window Edit Pane

In the edit pane of the Assessment window, you can configure trace 
assessments. You can show and hide the edit pane by clicking the Edit Pane 
toolbar button  or Edit Pane on the View menu.

In the Assessment area, the available assessments are displayed. By using the 
Assessment area shortcut menu, you can process the assessments. To open 
the shortcut menu, right-click in the Assessment area.

Figure 3-17:
Assessments area 
shortcut menu

Table 3-9:
Commands on the 
Assessment area 
shortcut menu

Command Description

New Opens the New Assessment dialog box for 
configuring an assessment.

New with Assistant Facilitates generating all meaningful assessments 
for a test or two different tests.

Delete Deletes the selected assessment.
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To configure an assessment:

1. Under Winding Assessment, select the algorithm (see 4.5 "Analysis 
Algorithms" on page 88) you want to use for the assessment.

2. Do one of the following:

• In the Assessments area, click New.

• Click the New Assessment toolbar button .

• Click New on the Assessment menu.

Figure 3-18:
New Assessment 
dialog box

3. In the New Assessment dialog box, select the test traces for the 
assessment.
You can select the traces belonging to a test or to a comparison as described 
later.
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4. Under Trace 1, do one of the following:

• Click Transformer and test, and then click the transformer associated 
with the test in the Transformer list and the test including the trace you 
want to add to the assessment in the Test list.

• Click Comparison, and then click the comparison including the trace you 
want to add to the assessment in the Comparison list.

5. In the list of traces available for the selection, click the trace you want to add 
to the assessment.

6. Under Trace 2, select the second trace you want to add to the assessment.

7. Click OK.

Under Display Filter, select the All traces, High voltage side, 
Low voltage side or Tertiary voltage side check box to display the respective 
traces in the list of traces available for the selection.

After clicking OK in the New Assessment dialog box, the assessment appears 
in the Assessments area and the calculated winding assessment factors for the 
low frequency, medium frequency and high frequency ranges as well as the 
overall winding assessment are displayed under Winding Assessment. To 
display the assessed test traces and the winding assessment factors of another 
assessment, click the assessment in the Assessments area.

By using the New with Assistant command on the Assessment menu, you 
can generate all meaningful assessments for a test or two different tests.

To generate all meaningful assessments for a test:

1. On the Assessment menu, click New with Assistant.

2. In the Assessment Generation Assistant dialog box, click 
Generate assessments for traces of a single test, and then click Next.

3. In the Transformer list, click the transformer associated with the test.

4. In the Test list, click the test including the traces for which you want to 
generate assessments.

5. Optionally, select the High voltage traces, the Low voltage traces or the 
Tertiary voltage traces check box to select the respective test traces, and 
then click Next.

6. Click Finish.

To generate all meaningful assessments for two different tests:

1. On the Assessment menu, click New with Assistant.

2. In the Assessment Generation Assistant dialog box, click 
Generate assessments for traces from two different tests, and then 
click Next.
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3. Under Test 1, click the transformer associated with the former test in the 
Transformer list and the test including the traces for which you want to 
generate assessments in the Test list.

4. Under Test 2, click the transformer associated with the latter test in the 
Transformer list and the test including the traces for which you want to 
generate assessments in the Test list.

5. Optionally, select the High voltage traces, the Low voltage traces or the 
Tertiary voltage traces check box to select the respective test traces.

6. Optionally, select the 
Generate only assessments for the corresponding traces check box to 
generate only assessments for the traces including the same windings.

7. Click Finish.

3.4.2   Assessment Window Display Pane

The display pane of the Assessment window displays the frequency responses 
of the assessed test traces. For the shortcut menu commands, see 
3.2.2 "Test View Window Display Pane" on page 51.

3.4.3   Assessment Window Cursor Pane

In the cursor pane of the Assessment window, you can examine the 
measurement results in detail. For the test traces assigned to the cursors, the 
cursor pane displays the frequency and measured values at cursor positions. To 
assign a test trace to a cursor, select the check box next to the cursor, and then 
click the trace in the corresponding Trace list. You can show and hide the cursor 
pane by clicking the Cursors Table toolbar button  or Cursors Table on the 
View menu.
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3.5    Toolbar

The toolbar provides quick access to the frequently used commands. You can 
show and hide the toolbar by clicking Toolbar on the View menu.

Figure 3-19:
Standard toolbar

Figure 3-20:
Display Settings 
toolbar

Import Test
or Transformer

New Test

Sweep Settings

New Assessment

Edit Pane

Preview Trace

Continuous
Measurement

Export Test
or Transformer

New Transformer

New Trace

Stop
Measurement

New Comparison

Add To Comparison

Cursors Table

Start Measurement

Back

Calibration

Scaling: Logarithmic

Show Group

Display Traces As

Scaling: Linear Optimize Zoom: All



65

The FRAnalyzer Software

3.6    Status Bar

The status bar at the bottom of the windows shows the comparison, the 
transformer and the test selected and the measurement status.

Figure 3-21:
Status bar

Table 3-10:
Measurement status

Selected comparison

Selected transformer

Selected test

 Calibration status

Selected trace

 Measurement status

Measurement Status Symbol Description

Status busy The FRAnalyzer performs internal 
calibration after it was connected to 
the computer.

Measurement running The FRAnalyzer performs a 
measurement.

Status online The FRAnalyzer is connected to the 
computer.

Status offline The FRAnalyzer is not connected to 
the computer.
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3.7    Setting Options

You can set general configuration options of the FRAnalyzer software in the 
Options dialog box. To open the Options dialog box, click Options on the 
Tools menu. After clicking the respective tab in the Options dialog box, you can 
set the general options, the chart and cursor options, the sweep settings options, 
the transformer’s terminal names, the default colors of the transformer’s 
terminals, the levels for the winding assessment factors, and the advanced 
measurement options.

On the General tab, you can set the user interface and reporting (see 
3.10 "Reporting" on page 80) language, the oil temperature unit displayed by the 
FRAnalyzer software as well as some behavior options.

Figure 3-22:
General options
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Under Localization/Globalization:

• In the Language list, select the language you want to use for the user 
interface and reporting.

Note: After changing the language, restart the FRAnalyzer software.

• In the Unit for oil temperature list, select the oil temperature unit you want 
to be displayed by the FRAnalyzer software.

Under Behavior, select the Clear <default> comparison on exit check box to 
clear the measurement results in the <default> comparison when exiting the 
FRAnalyzer software.

Under Reporting (Printing), select the Print on paper with letterhead check 
box and enter the margin at the top of the first page to set the respective options 
for printing the reports.

On the Chart and Cursors tab, you can set the display properties of traces and 
cursors.

Figure 3-23:
Chart and cursors 
options
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Under Chart and Traces:

• In the Chart background list, select the background color of the display 
panes.

• In the Normal line width for traces list, enter the normal line width.

• In the Line width for highlighted traces list, enter the line width of the 
selected traces.

Under Cursors:

• Click in the Color bars, and in the Color palette, set the cursor colors.

• In the Line width boxes, enter the width of the cursor lines.

• In the Line style boxes, click the style of the cursor lines.

Note: The style of the cursor lines is selectable only for the cursor line width 
of 1 pixel.

On the Sweep Settings tab, you can manage the sweep settings profiles. The 
FRAnalyzer software is delivered with non-editable profiles selectable in the 
Default sweep settings profile list. You can configure and save your own 
sweep settings profiles.

Figure 3-24:
Sweep settings options
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To create your own sweep settings profile:

1. On the Sweep Settings tab, click the New button.

2. In the New Profile dialog box, type the profile name.

3. Click OK to get back to the Options dialog box.

4. Under General, enter:

• Start and stop frequencies

• Input impedance

Note: The input impedance of 50  is the standard setting for all default 
test traces and the recommended connection technique. Select the 1 M 
input impedance only in well-founded cases, for example for measuring 
the transformation ratio or when using an alternative connection 
technique such as fibre optic cables.

• Receiver bandwidth

Note: A narrow receiver bandwidth suppresses the most noise 
interference but slows down the sweep. A broad receiver bandwidth 
results in fast measurements with a reduced noise immunity of the 
FRAnalyzer. The option <adapt automatically> (recommended) adapts 
the receiver bandwidth during the measurement for the best signal-to-
noise ratio.

• Total number of measurement points

• Sweep mode

5. Under Noise Suppression, select the attenuation in the measurement 
channel:

• 0 dB to get the best signal-to-noise ratio with moderate risk of overload

• 10 dB to get good signal-to-noise ratio with low risk of overload

• 20 dB to get measurement results compatible with those obtained with 
the FRAnalyzer Version 1.0

• <adapt automatically> (recommended) to adapt the attenuation during 
the measurement for the best signal-to-noise ratio without risk of overload

6. If you want to customize the distribution of the measurement points, proceed 
as follows.



 FRAnalyzer User Manual

70

Note: By customizing the distribution of the measurement points, you can 
increase the quality of your measurement with respect to the resolution and 
measurement time. Typically, 20 linearly distributed measurement points are 
sufficient within the range 20 Hz…200 Hz. At higher frequencies, a higher 
resolution is necessary due to the enhanced information content. 
Consequently, it is more suggestive to distribute the measurement points not 
evenly.

7. Under Customize Frequency Ranges, repeatedly click the 
Add Frequency Range button to generate as many frequency subranges as 
you want.

8. Select a frequency subrange.

9. In the From Frequency box, enter the lowest frequency of the subrange.

10.In the To Frequency box, enter the highest frequency of the subrange.

Note: The start and stop frequencies chosen under General cannot be 
changed here. You can only set the distribution of the subranges.

11.In the Number of Points box, change, if necessary, the number of 
measurement points within the subrange. The maximum number of points 
per range is 400.

12.In the Sweep Mode box, click linear or logarithmic to select the respective 
sweep mode.

13.Repeat steps 8 to 12 to customize the measurement point distribution within 
the whole frequency range.

14.Click OK to save the sweep settings profile.

Note: Click Remove Frequency Range to delete the selected subrange, or 
click Remove All to remove all subranges.

To delete a user-defined sweep settings profile:

1. In the Default sweep settings profile list, select the profile you want to 
delete.

2. Click the Delete button.

To set the default sweep settings profile:

1. In the Default sweep settings profile list, click the profile you want to use 
as default.

2. Click OK.
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On the Terminal Names tab, you can set the transformer’s terminal naming 
conventions according to different standards and define your own terminal name 
profiles.

Figure 3-25:
Terminal names options

In the Terminal name profile list, select ANSI, IEC or VDE to set the 
transformer’s terminal naming conventions according to the respective 
standard.

To define your own terminal name profile:

1. On the Terminal Names tab, click the New button.

2. In the New Profile dialog box, type the profile name, and then click OK.

3. Under High Voltage Side, Low Voltage Side and Tertiary Voltage Side, 
enter your preferred naming conventions, and then click OK.
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To delete a user-defined terminal name profile:

1. In the Terminal names profile list, select the profile you want to delete.

2. Click the Delete button.

On the Trace Colors tab, you can set the default colors of the transformer’s 
terminals and define your own trace color profiles.

Figure 3-26:
Trace colors options

To define your own trace color profile:

1. On the Trace Colors tab, click the New button.

2. In the New Profile dialog box, type the profile name, and then click OK.

3. Under Trace Colors, click in the bars next to the trace names, and in the 
Color palette, set the default colors of the transformer’s terminals.
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To delete a user-defined trace color profile:

1. In the Trace color profile list, select the profile you want to delete.

2. Click the Delete button.

On the Analyses tab, you can set the default algorithm for the analysis of 
comparable test traces and the levels for the winding assessment factors. You 
can select the analysis algorithm according to the DL/T911-2004 and NCEPRI 
standards (see 4.5 "Analysis Algorithms" on page 88).

Figure 3-27:
Analyses options

To select the default analysis algorithm according to the DL/T911-2004 or 
NCEPRI standards, select the respective entry in the Analysis algorithm list.

Under Winding Assessment, you can set the threshold levels for the winding 
assessment factors. To set the default threshold levels recommended by the 
relevant standards, click Reset to Default Values.

Note: The overall winding assessment relies on the analysis algorithm with the 
threshold levels for the winding assessment factors recommended by the 
DL/T911-2004 and NCEPRI standards. For other threshold levels, the overall 
winding assessment does not comply with the underlying standards.
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On the Advanced tab, you can set the number of points and their distribution for 
data import from the FRAMIT test system to reduce the time required for 
processing the data.

Figure 3-28:
Advanced options

Under FRAMIT File Import:

• Click the number of points you want to import.

• Select or clear the Logarithmic distribution check box to set the logarithmic 
or the linear distribution of the measurement points.
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3.8    Sweep Settings

Any test with the FRAnalyzer is performed with specified sweep settings. The 
default sweep settings profile is set in the Options dialog box (see 3.7 "Setting 
Options" on page 66). You can set the frequency sweep parameters for any test 
individually according to your needs. We recommend to use the same sweep 
settings for the comparable tests.

Note: The sweep settings different from the settings of a default profile apply 
only to the selected test. You cannot change the sweep settings of a test after a 
trace has been measured.

To set the frequency sweep parameters of a test:

1. In the Data Management window (see 3.1 "Data Management Window" on 
page 33) or the Test View window (see 3.2 "Test View Window" on 
page 47), select the test whose sweep settings you want to set.

2. Click the Sweep Settings toolbar button  or Sweep Settings on the Test 
menu to open the Sweep Settings dialog box.

Figure 3-29:
Sweep Settings dialog 
box



 FRAnalyzer User Manual

76

3. In the Sweep Setting Profile list, select the profile you want to use as the 
basis for setting the frequency sweep parameters, and then follow steps 4 to 
13 of the procedure for configuring the your own sweep setting profiles on 
pages 69 to 70.

4. If you want to save the sweep settings in a profile, click the Save to Profile 
button, in the Save Sweep Settings to Profile dialog box, type the profile 
name, and then click OK.

5. In the Sweep Settings dialog box, click OK to assign the sweep settings to 
the selected test.
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3.9    Importing and Exporting Data

3.9.1   Importing Data

With the FRAnalyzer, you can import and export measurement results and, 
depending on the data format, also the associated transformer and test data. 
The FRAnalyzer software facilitates importing the data from FRA test systems 
of other manufacturers such as Doble, PAX Diagnostics and Haefely Test AG 
by supporting the data import in the manufacturer specific formats. All file 
operations are done in the usual Windows manner.

The FRAnalyzer software supports the following data formats for data import.

Table 3-11:
Supported data import 
formats Format File 

Extension
Description

FRAnalyzer fra FRAnalyzer native format1

1. Contains also the associated transformer and test data.

FRAnalyzer Transformer 
File

tfra FRAnalyzer native format2

2. Collection of multiple .fra files in a ZIP archive

FRAnalyzer CSV 2.0 csv Comma-separated values format

FRAnalyzer CSV 1.0 csv Comma-separated values format

CIGRE Exchange xfra Standard exchange format for trace 
data as defined by Cigré

FRAMIT 3.0 fra FRAMIT specific format

Doble sfra Doble specific format

Doble CSV csv Doble specific format

TDT4 dat China Electric Power Research 
Institute (CEPRI) specific format

TDT5 csv CEPRI specific format

TDT6 csv CEPRI specific format

Pax pax PAX Diagnostics specific format3

3. One file for the test data and a folder with one file for a test trace

FRAX CSV csv PAX Diagnostics specific format

FRAX txt PAX Diagnostics specific format

Tettex csv Tettex specific format
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To import a test:

1. Do one of the following:

• In the Data Management window, right-click in the Tests area, and then 
click Import.

• On the Test menu, click Import.

2. In the Open File dialog box, browse to the file containing the data you want 
to import.

By using the FRAnalyzer Transformer File format, you can import all tests for the 
associated transformer as follows:

1. Do one of the following:

• In the Data Management window, right-click in the Transformers area, 
and then click Import.

• On the Transformer menu, click Import.

2. In the Open File dialog box, browse to the file containing the data you want 
to import.

3.9.2   Exporting Data

The FRAnalyzer software supports the following data formats for data export.

Table 3-12:
Supported data export 
formats Format File 

Extension
Description

FRAnalyzer fra FRAnalyzer native format1

1. Contains also the associated transformer and test data.

FRAnalyzer Transformer 
File

tfra FRAnalyzer native format2

2. Collection of multiple .fra files in a ZIP archive

FRAnalyzer CSV 2.0 csv Comma-separated values format

CIGRE Exchange xfra Standard exchange format for trace 
data as defined by Cigré
For details, see Mechanical 
Condition Assessment of 
Transformer Windings Using 
Frequency Response Analysis 
(FRA), April 2008, Section 2.4.7.
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To export a test in the FRAnalyzer or FRAnalyzer CSV 2.0 format:

1. Do one of the following:

• In the Data Management window, right-click in the Tests area, and then 
click Export.

• On the Test menu, click Export.

2. In the Save Test dialog box, browse to the file you want to save the data to.

To export a test in the CIGRE Exchange format:

1. Do one of the following:

• In the Data Management window, right-click in the Tests area, and then 
click Export in CIGRE Format.

• On the Test menu, click Export in CIGRE Format.

2. In the Browse for Folder dialog box, browse to the folder you want to save 
the data to.

Note: When saving a file, one file per trace is created and the file names are 
generated automatically in accordance with the Cigré standard.

By using the FRAnalyzer Transformer File format, you can export all tests for the 
associated transformer as follows:

1. Do one of the following:

• In the Data Management window, right-click in the Transformers area, 
and then click Export.

• On the Transformer menu, click Export.

2. In the Save Transformer and Tests dialog box, browse to the file you want 
to save the data to.

3.9.3   Maintaining the Database

The FRAnalyzer data is organized in a database on the hard disk of your 
computer. It is recommended to periodically store the data in a removable data 
storage device to protect it against loss or damage. To back up the data, click 
Backup Database on the File menu, and then save the data in an archive file.

Note: Restoring the database overwrites the data in the database.

To restore the database from the archive file, click Restore Database Backup 
on the File menu, and then browse to the file containing the data you want to 
restore.

Note: You can only restore the databases created with the same or an earlier 
version of the Microsoft SQL Server as installed on your system.
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3.10    Reporting

You can print a report on a test. The test report includes the transformer and test 
data, the measurement results and assessments. To print a test report, click 
Print on the File menu. You can also export the report data in a Microsoft 
Excel™ worksheet to easily create fully customized reports. To export the report 
data, click Export Report As Excel File on the File menu.

Alternatively, you can copy a diagram to the clipboard and then process it by 
using another application, for example Microsoft Word. To copy the displayed 
diagram to the clipboard, right-click in the display pane of the Test View window, 
the Comparison window or the Assessment window, and then click Copy.

3.11    Calibrating the FRAnalyzer

The FRAnalyzer is calibrated automatically on startup. It is recommended to 
calibrate the FRAnalyzer before performing a test or after changing the cables 
to eliminate the effect of the cables.

Note: The calibration applies only to the selected test. The calibration is not 
available for tests with customized sweep ranges.

To calibrate the FRAnalyzer:

1. In the Data Management window or in the Test View window, select the test 
for which you want to calibrate the FRAnalyzer.

2. Click Calibration on the Tools menu.

Figure 3-30:
Calibration dialog box
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3. Connect the SOURCE connector to both the REFERENCE connector and 
the MEASUREMENT connector using the delivered BNC T adapter.

Figure 3-31:
BNC T adapter

4. In the Calibration dialog box, click the Perform Calibration button and wait 
until the calibration is finished. The calibration takes about 100 s.
After the calibration has been finished, Calibration performed is displayed 
in a green box.

5. Click Close.

Note: The calibration status is displayed in the status bar (see 3.6 "Status Bar" 
on page 65).
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4     Testing with the FRAnalyzer

With the FRAnalyzer, you can measure frequency responses of the transformer 
windings, compare the measurement results and assess the transformer 
windings by calculating the difference between the measurement results of two 
comparable test traces.

4.1    Test Traces

For testing with the FRAnalyzer, the test traces are of fundamental importance. 
The frequency response of the test trace strongly depends on the vector group 
of the transformer and the measurement type (for example, end-to-end, 
interwinding, and others). When adding a new test, the default test traces are 
created automatically according to the FRA testing recommendations. You can 
intentionally change them for your specific applications.

Typically, you do not need to change the default test traces. In well-founded 
cases, you can delete the default test traces and add new test traces. In 
particular, in typical FRAnalyzer applications proceed as follows:

• If you want to test a transformer for the first time, create a new test with the 
transformer under test associated with the test (see "Tests Area" on 
page 40). Then the default test traces are likely the traces you want to test.

• If you want to compare the current measurement results with the reference 
measurement results, create a new test by using the reference test as 
template (see "Tests Area" on page 40). Then the default traces created by 
the test template are exactly the traces you want to test.

• If you want to test a transformer in your own way, customize the traces you 
want to measure (see "Traces Area" on page 43).

You can change the test trace line colors by using the Change Color command 
(see 3.2.1 "Test View Window Edit Pane" on page 48).
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4.2    Performing Measurements and Tests

Before performing measurements with the FRAnalyzer, you must create the 
transformer under test, a test and the test traces you want to measure. For 
detailed information on how to add a transformer, a test and test traces, see 
3.1 "Data Management Window" on page 33.

To measure a test trace:

1. Add the transformer under test (see "Transformers Area" on page 38).

2. Add a test with test traces (see "Tests Area" on page 40 and 4.1 "Test 
Traces" on page 83).

3. Optionally, change the default test traces (see "Traces Area" on page 43).

4. In the Traces area of the Data Management window, select the test trace 
you want to measure.

5. Click the Trace Details tab, and then connect the FRAnalyzer to the 
transformer’s terminals as shown by the Red and Blue boxes.
For detail information on the connection technique, see 2.4 "Connecting the 
FRAnalyzer to a Power Transformer" on page 28.

6. Do one of the following:

• Click the Start Measurement toolbar button .

• Right-click the selected trace, and then click Start Measurement.

• Click Start Measurement on the Trace menu.

• Under Selected Trace, click the Start button.

7. Click the Test View tab to display the measurement results (see 
3.2 "Test View Window" on page 47).

After the measurement has been finished, the measurement results are saved 
in the FRAnalyzer database and the symbol  is displayed in the State column 
of the trace record.

To stop a measurement, do one of the following:

• Click the Stop Measurement toolbar button .

• Right-click the test trace being measured, and then click 
Stop Measurement.

• Click Stop Measurement on the Trace menu.

• Under Selected Trace, click the Stop button.

After you stopped a measurement, the measurement results obtained until then 
will be cleared.
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To perform a complete test, repeat steps 4 to 7 of the procedure described 
earlier in this section for all test traces. After the test has been completed, the 
symbol  is displayed in the State column of the test record.

To clear the measurement results, do one of the following:

• Right-click the trace whose results you want to clear, and then click 
Clear Results.

• Click the trace whose results you want to clear, and then click Clear Results 
on the Trace menu.

The FRAnalyzer provides additionally a measurement mode for continuous 
measurements without saving the measurement results. In the continuous 
measurement mode, the frequency is repeatedly swept from the start frequency 
to the stop frequency and the measurement results are graphically displayed.
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To start the continuous measurement mode:

1. Click the Continuous Measurement toolbar button  or 
Continuous Measurement on the Tools menu to open the 
Continuous measurement dialog box.

2. Under Settings to be used, click:

• From test, and then select the test whose settings you want to use.

• From profile, and then select the profile whose settings you want to use.

• Custom settings, and then customize the sweep settings as described 
in 3.8 "Sweep Settings" on page 75.

3. Under Display Color, optionally set the display color of the continuous 
measurement.

4. Click the Run Continuous Measurement button.
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4.3    Comparing the Measurement Results

You can diagnose the defects in the transformer windings and magnetic core by 
comparing the measurement results for comparable test traces. Comparable 
test traces are:

• The same transformer windings measured at different times

• Windings on the same voltage side of one transformer

• Windings on the same voltage side of transformers of the same type and 
construction, so-called "sister units"

For detailed information on how to work with comparisons, see 3.3 "Comparison 
Window" on page 54.

To compare measurement results:

1. In the Comparison window, add a comparison (see 3.3.1 "Comparison 
Window Edit Pane" on page 55).

2. Add comparable test traces to the comparison (see 3.3.1 "Comparison 
Window Edit Pane" on page 55).

3. Compare the frequency responses of the compared test traces visually (see 
3.3.2 "Comparison Window Display Pane" on page 58).

4.4    Assessing the Transformer Windings

With the FRAnalyzer, you can assess the transformer windings by calculating 
the winding assessment factors of the frequency responses of two comparable 
test traces. You can calculate the winding assessment factors by using different 
algorithms (see 4.5 "Analysis Algorithms" on page 88). For detailed information 
on how to work with assessments, see 3.4 "Assessment Window" on page 59.

To assess the transformer windings:

1. Click the Assessment tab to open the Assessment window.

2. Under Winding Assessment, select the algorithm (see 4.5 "Analysis 
Algorithms" on page 88) you want to use for the assessment.

3. Add and configure an assessment of comparable test traces (see 
3.4.1 "Assessment Window Edit Pane" on page 60).

4. Under Winding Assessment, read the winding assessment factors for the 
respective frequency ranges and the overall winding assessment.
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4.5    Analysis Algorithms

The assessment of the transformer windings under test is based on two different 
algorithms described later.

4.5.1   DL/T911-2004

DL/T911-2004 is a standard for the frequency response analysis widely used in 
the People's Republic of China. For detailed information, see the China Electric 
Power Publishing Co. website www.cepp.com.cn. The algorithm evaluates the 
similarity of the frequency responses of two transformer’s test traces by 
calculating the factors RLF, RMF and RHF (see Table 4-1: "Winding assessment 
factors according to the DL/T911-2004 standard").

The basic underlying formulas of the DL/T911-2004 algorithm include:

(Eq. 4-1)

(Eq. 4-2)

(Eq. 4-3)

(Eq. 4-4)

(Eq. 4-5)

where ,  are comparable frequency response sequences of length .

The algorithm evaluates the factor  at fixed frequencies within the frequency 
range 1 kHz…1 MHz. Consequently, the algorithm works only for frequency 
responses including measurement results within 1 kHz…1 MHz. Measurement 
results out of this range are not considered. The factor  evaluated in different 
frequency ranges yields the winding assessment factors as given in the 
following table.
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Table 4-1:
Winding assessment 
factors according to the 
DL/T911-2004 standard

Using the winding assessment factors described in the preceding table, the 
transformer winding deformation conditions are defined as follows.

Note: The data in the following table applies to the power transformers with 
S > 1 MVA.

Table 4-2:
Winding assessment 
according to the 
DL/T911-2004 standard

Note: The algorithm according to the DL/T911-2004 standard analyzes only 
comparable test traces (the same test trace at different times or the same 
voltage side windings) if the measurement results cover the frequency ranges 
required for the calculation of the winding assessment factors (see Table 
4-1: "Winding assessment factors according to the DL/T911-2004 standard" on 
page 89). In all other cases, the calculated winding assessment factors have no 
meaning or cannot be calculated and the FRAnalyzer displays 
Assessment Not Possible.

Winding Assessment Factor Frequency Range

RLF 1 kHz…100 kHz

RMF 100 kHz…600 kHz

RHF 600 kHz…1 MHz

Winding Deformation Degree Winding Assessment Factors

Normal winding RLF  2.0 AND RMF  1.0 AND RHF  0.6

Slight deformation 2.0 > RLF  1.0 OR 0.6 RMF < 1.0

Obvious deformation 1.0 > RLF  0.6 OR RMF < 0.6

Severe deformation RLF < 0.6
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As an example, the Figure 4-1: "Winding assessment of an intact transformer" 
shows the winding assessment of an intact transformer.

Figure 4-1:
Winding assessment of 
an intact transformer
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As an example, the Figure 4-2: "Winding assessment of an defective 
transformer" shows the winding assessment of an defective transformer.

Figure 4-2:
Winding assessment of 
an defective 
transformer

4.5.2   NCEPRI

NCEPRI is an alternative established method for the transformer winding 
deformation assessment. For detailed information, see the NCEPRI website 
www.ncepri.com. The algorithm evaluates the similarity of the frequency 
responses of two transformer’s test traces by calculating their root mean-square 
deviation

(Eq. 4-6)

where ,  are comparable frequency response sequences of length  
in dB.
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The winding assessment factor  is evaluated in different frequency ranges 
for the high-voltage, low-voltage and tertiary windings as given in the following 
table.

Table 4-3:
Frequency ranges 
according to the 
NCEPRI standard

Using the winding assessment factor , the transformer winding deformation 
conditions are defined as follows.

Table 4-4:
Winding assessment 
according to the 
NCEPRI standard

Note: The algorithm according to the NCEPRI standard analyzes only 
comparable test traces (the same test trace at different times or the same 
voltage side windings) if the measurement results cover the frequency ranges 
required for the calculation of the winding assessment factor (see Table 
4-3: "Frequency ranges according to the NCEPRI standard"). In all other cases, 
the calculated winding assessment factor has no meaning or cannot be 
calculated and the FRAnalyzer displays Assessment Not Possible.

Note: The overall winding assessment relies on the analysis algorithm with the 
levels for the winding assessment factors recommended by the respective 
standards and consequently cannot be guaranteed by OMICRON electronics.

E12

Winding Frequency Range

High-voltage 10 kHz…515 kHz

Low-voltage 10 kHz…600 kHz

Tertiary-voltage 10 kHz…700 kHz

E12

Winding Distortion Level Winding Assessment Factor in dB

Normal condition E12 < 3.5

Slight distortion 3.5 < E12 < 7.0

Severe distortion E12 > 7.0
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5     Application Example

5.1    Introduction

The following application example guides you step by step through an FRA test 
using the FRAnalyzer. As a typical example, a 110 kV/28 kV/10.75 kV-rated 
60 MVA power transformer with the YNyn0d5 vector group is tested.

Note: Observe all local safety instructions to isolate the transformer.

Figure 5-1:
Power transformer 
under test

Table 5-1:
Winding organization of 
the tested transformer Winding

High-voltage side Low-voltage side Tertiary-voltage side

V

U W

N

v1

u1 w1

n1

u2

w2

v2
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For detailed information on using the FRAnalyzer software, see 3 "The 
FRAnalyzer Software" on page 33 or the FRAnalyzer Help. By following the test 
procedure, you can practice operating the FRAnalyzer. To obtain the test data 
without testing a real transformer, import the Sample Test_1.tfra and 
Sample Test_2.fra files available in the Sample Tests folder on the FRAnalyzer 
CD-ROM.
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5.2    Preparing the Test

With the FRAnalyzer, you can prepare an FRA test by setting all relevant data 
before on-site testing. After then, a field test controlled by the FRAnalyzer 
software runs, requiring only selection of the predefined test traces and 
connection of the corresponding transformer’s terminals. After the test has been 
completed, you can assess the transformer windings.

Note: Before performing measurements, it is recommended to calibrate the 
FRAnalyzer (see 3.11 "Calibrating the FRAnalyzer" on page 80).

5.2.1   Adding a Transformer Record

After starting the FRAnalyzer software, add a transformer record in the 
Data Management window. On the Transformer Details tab, enter the 
transformer data as follows. Note that the number of phases and the vector 
group match the transformer winding organization (see Table 5-1: "Winding 
organization of the tested transformer" on page 93).

Figure 5-2:
Transformer data
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5.2.2   Adding a Test Record

In compliance with the terminal naming conventions used at the tested 
transformer, set the Terminal Names option to the CIGRE standard. In the 
Data Management window, add a test record. Click the Test tab, and then type 
the test details as follows.

Figure 5-3:
Test details

In the Traces area, check the test traces. The test traces are created according 
to the recommendations for the transformer under test and you do not need to 
change them.

Figure 5-4:
Test traces

When testing a transformer, check and, if necessary, change the Tap Changer, 
Delta Winding Open and Other Winding settings on the transformer as 
specified by the test traces.



97

Application Example

Note: It is recommended to use the logarithmic distribution of the measurement 
points. Typically, it is advantageous to set more measurements points in the 
upper part of the frequency range by adding frequency subranges (see 
3.7 "Setting Options" on page 66).
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5.3    Putting the FRAnalyzer into Operation

Connect the FRAnalyzer to the power transformer under test as follows (for the 
accessories used, see 1.2.4 "Delivery" on page 20):

1. Connect the yellow, red and blue coaxial cables to the SOURCE, 
REFERENCE and MEASUREMENT connectors of the FRAnalyzer 
respectively.

Figure 5-5:
Connecting coaxial 
cables

2. Connect the grounding cable to the equipotential ground terminal on the 
FRAnalyzer rear panel, and clamp its other end to the transformer tank.

Figure 5-6:
Grounding the 
FRAnalyzer

3. Connect the FRAnalyzer to the computer using a USB cable (see 
2.3 "Connecting the FRAnalyzer to the Computer" on page 26).

4. Power the FRAnalyzer (see 2.2 "Powering the FRAnalyzer" on page 24).

For each trace test, connect the FRAnalyzer to the corresponding transformer’s 
terminals as described in 5.4 "Connecting the FRAnalyzer to the Transformer’s 
Terminals" later. To complete the test, repeat the procedure for all test traces.



99

Application Example

5.4    Connecting the FRAnalyzer to the 
Transformer’s Terminals

To perform a measurement, for example of the N U test trace, connect the 
FRAnalyzer to the transformer’s terminal bushings N and U. For detailed 
information on the connecting technique, see 2.4 "Connecting the FRAnalyzer 
to a Power Transformer" on page 28.

To connect the FRAnalyzer to the transformer’s terminal bushings N and U:

1. Connect the yellow and red coaxial cables to the transformer’s terminal 
bushing N using a bushing clamp.

2. Ground the bushing clamp using two aluminium braids and the screw 
clamps.

3. Connect the blue coaxial cable to the transformer’s terminal bushing U using 
a bushing clamp.

4. Ground the bushing clamp using two aluminium braids and the screw 
clamps.
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5.5    Measuring the Test Traces

To measure a test trace:

1. In the Test View window, select the trace you want to measure.

2. Click the Start Measurement toolbar button  or the Start button to start 
the measurement.

Figure 5-7:
N U trace measurement
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3. Repeat the measurement for all test traces.

Figure 5-8:
Measurement results
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5.6    Assessing the Transformer Windings

To assess the transformer windings, compare the measured frequency 
responses of the test traces with a previous reference test. For this purpose, 
import the reference test data available in the 
1593901 - Sample Reference Test.fra file in the Sample Tests folder on the 
FRAnalyzer CD-ROM.

Figure 5-9:
Reference test
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To assess the transformer winding under test:

1. Click the Assessment tab to open the Assessment window.

2. Under Winding Assessment, select the algorithm you want to use for the 
assessment.

3. Add and configure an assessment of two comparable traces, for example the 
N U traces of the Sample Test and the Sample Reference Test.

4. Under Winding Assessment, read the winding assessment factors for the 
respective frequency ranges and the overall winding assessment.

Figure 5-10:
Transformer winding 
assessment

Note: The overall winding assessment relies on the analysis algorithm with the 
levels for the winding assessment factors recommended by the respective 
standards and consequently cannot be guaranteed by OMICRON electronics.
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6     Technical Data

6.1    The FRAnalyzer Specifications

Table 6-1:
The FRAnalyzer 
specifications Characteristic Rating

Frequency range 10 Hz…20 MHz

Source Output

Output impedance 50 

Connector BNC

Wave form Sinusoidal signal

Amplitude 1 Vrms at 50  load

Reference (CH 1) and Measurement (CH 2) Inputs

Input impedance Low or high impedance selectable

Low impedance Input impedance 50 

High impedance Input impedance 1 M ±2%
Input capacitance 40…55 pF

Connectors BNC

Input sensitivity 2.83 Vp-p

Dynamic range > 120 dB

Accuracy < 0.1 dB (down to –50 dB) and
±1 dB (between –50 dB and –80 dB)
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6.2    Computer Requirements

Table 6-2:
Computer requirements

6.3    Power Requirements

Table 6-3:
Power requirements

Characteristic Requirement

Minimum configuration Intel-based processor 1 GHz,
1 GB RAM, CD-ROM drive

Interface USB 1.1 or USB 2.0

Operating system Microsoft Windows XP or Windows 
Vista

Power Supply Rating

Battery Pack

Nominal voltage 12 V

Rated capacity 3.4 Ah

Operating time1

1. Typical value

6 h

Charging time1 5 h

Nominal charging current 1 A

Fuse 2 A quick acting F

Transportation No transportation constraints apply.

AC Power Supply

Input voltage/frequency 100…240 V/50…60 Hz
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6.4    Environmental Requirements

Table 6-4:
Environmental 
requirements

6.5    Mechanical Data

Table 6-5:
The FRAnalyzer 
mechanical data

Characteristic Condition Rating

Temperature Storage –35…+60ºC/–31…+140ºF

Operating –10…+55ºC/+14…+131ºF

For specifications 23ºC ± 5ºC/73ºF ± 9ºF
with < 1ºC/1.8ºF deviation from the 
calibration temperature
(error-corrected temperature range)

Relative humidity Storage 20…95%, non-condensing

Operating 20…95%, non-condensing

Characteristic Rating

Dimensions (w × h × d) 26 × 5 × 26.5 cm/10.24 × 2 × 10.5 inch

Weight < 2 kg/4.4 lb (without measuring cables)
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Contact Information / Technical 
Support

Europe, Africa, Middle East

OMICRON electronics GmbH
Oberes Ried 1, A-6833 Klaus, Austria

Phone: +43 5523 507-333

E-Mail: support@omicron.at

Web: www.omicron.at

Asia, Pacific

OMICRON electronics Asia Ltd, Hong Kong

Phone: +852 2634 0377

E-Mail: support@asia.omicron.at

Web: www.omicron.at

North and South America

OMICRON electronics Corp. USA

Phone: +1 713 830-4660 or 1 800 OMICRON

E-Mail: techsupport@omicronusa.com

Web: www.omicronusa.com

For addresses of OMICRON offices with customer service centers, regional 
sales offices or offices for training, consulting and commissioning please visit 
our Web site.
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